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I Introduction 
The HVpilot software controls the HVcontrol and STEPcompact and receives measured data from the 
ICMcompact and/or a tan delta measuring bridge (TDAcompact or Tettex 2877, optional). The HVcontrol 
resp. the STEPcompact controls the variac of a high voltage transformer and together with the HVpilot soft-
ware they are designed to automate high voltage test sequences. The instruments are connected to the PC 
via the serial interface. The HVpilot software provides the possibility to program a test sequence, analyses 
the measured data and generates a report automatically. For this purpose, there are several different test 
sequences available. 

II Starting the Program 
The HVpilot software can be started via the Windows Explore; the Start Menu; OR THE SHORTCUT ICON 
ON THE DESKTOP. 

On PCs running Windows 10 with the Creator's Update of 2017 the 
ICMsystem application window may appear very small on high resolu-
tion monitors. To enlarge the display size of the software, please take 
the following steps: 

1. Right-click on the application short cut on the desktop. 
2. Choose "Properties" from the context menu, which will open the 

Properties window. 
3. Enable "Override high DPI scaling behaviour" and set "Scaling 

performed by" to "System" on the "Compatibility" tab. 
4. If you have administrator rights, you can change the settings for all 

users by clicking the corresponding button. 
5. Approve the change by clicking "OK". 
 
 
 
 
 
 

 

Fig. II.1: Properties window 

Fig. II.2: Desktop before and after change of scaling behavior 
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After the program start the COM ports of the PC are 
scanned for the HVcontrol/STEPcompact, the ICMcom-
pact, and the tan delta measuring bridge. Figure II.3 shows 
the result dialogue box. To establish a connection to an 
instrument, select the corresponding check box and click 
OK. If an instrument was selected, the software establishes 
the connections to the selected instruments. 

The main panel (figures  II.4 and II.5) shows the strip chart 
view in which the actual measurement values are displayed 
continuously. To clear the display, use the View menu or 
the toolbar and select 'Clear Strip chart'. The boxes 
STEPcompact, ICMcompact and TDAcompact on the left 
side indicate a valid connection to these instruments 
(Online). It is possible to disconnect or connect to an in-
strument by clicking on the corresponding box and select-
ing the respective option. The boxes underneath display 
the actual measurement values of the PD activity, voltage, tan delta, capacitance, and frequency, if the re-
spective instruments are online. 

Beside the continuous strip chart a second graph for the last saved or loaded measurements is available. To 
toggle between these two graphs, use the View menu or the toolbar and select 'Strip Chart' or 'Result Graph'. 
While 'Result Graph' is selected, a cursor to read out measurements is available. To move the cursor, use 
the mouse left button. The values for the PD activity, voltage, tan delta, and capacitance at that selected time 
are displayed above the graph. Underneath the graph a voltage curve is shown. This curve represents either 
the active voltage curve of the HVcontrol/STEPcompact or, if the instrument is not connected, the voltage 
curve of the loaded measurement data file. By moving the cursor of the result graph, the cursor in the dis-
played voltage curve is moved as well. The boxes on the right side of this graph display the set voltage value 
and the time for the cursor position. 

The graphs for PD activity, voltage, tan delta, and the capacitance can be blinded out by the respective 
check boxes on the left side of the panel. Besides, the colours of the graphs can be changed by the colour 
boxes. 

 

Fig. II.3 Device search dialogue 
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Fig. II.5 Main panel; shows a loaded data file, no instruments are connected 

Fig. II.4 Main panel; ICMcompact and HVcontrol are connected, strip chart view 
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III Menu Options 
Some of the menu options can be found in the button bar at the bottom of the screen. 

III.1 File Menu 

Load Measurement (F4) 
By selecting this menu option, a stored data file can be loaded. There 
are two different data file types which can be loaded (*.hvp and *.hvs). 
The .hvp files contain the measured values of a normal measurement, 
whereas the data of a test sequence are stored in the .hvs files. 
Among the raw measurement data, the files contain information about 
the instrument setups, voltage curve and the test sequence. 

Save Measurement (F5) 
The actual measurement data can be stored in a .hvp file by selecting this menu option. This stores the ac-
tual setups and voltage curve as well. 

Directories 
In the directories dialogue box, the default directories for the template, document and data files can be set. 
These directories must be specified when the program is launched for the first time. The default is the appli-
cation directory. If the .ini file of a previous software installation is available, the directory paths are copied 
from this version (only software version 2.3 and higher). 

1. 'Templates directory':  
Is used to store and load the test templates. If some templates have been changed, and a new version 

Fig. III.2 File menu 

Fig. III.1 Menu bar 

Fig. III.3 Directories dialogue box 
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of the HVpilot software is installed, the 'Templates Directory' can be set to the old directory to use the 
modified templates. 

2. 'Documents': 
Contains the report templates in doc format. 

3. 'XML/TPL Template Input':  
Specifies the directory for templates in XML or TPL format. 

4. 'Default Data Directory':  
Is used as the default path for all load and save dialogues and is the default directory for storing of the 
test data. 

5. 'Complete Reports (Bushing Test)':  
Directory for saving special bushing test reports. 

6. 'Export Files / Output':  
Directory for saved pattern and other output files. 

7. 'Daily Reports (Bushing Profile Test, Multiplexer Test)':  
Directory for a summarising report that accumulates all measurement reports of the current day. 

8. 'Parent Directory for Templates (Profile Test)':  
Special directory for profile test templates. 

9. 'Parent Directory for Data Export (Profile Test)':  
Excel sheets, reports and .hvs files of profile tests are store in this directory. 

Export 
This menu option offers the possibility to export the raw 
measuring data to an Excel sheet, a Word document, or 
an ASCII file (*.txt). Besides, some information about the 
tested object can be added to the report. Figure III.5 
shows the dialogue box for additional information. 

The box 'Export Time Interval' defines the time interval 
between two readings for the report. The minimum time 
is about two seconds, due to the scanning time for further 
connected instruments. 

With the 'Multiple Measurements' command it's possible 
to create a summarising report for multiple profile tests. 

Create Report 
If a test sequence file (*.hvs) is loaded or a test sequence 
is carried out, this menu option offers the possibility to 
create the test report again. 

Create Complete Report 
For bushing tests, it is possible to combine several tests 
in one report as described in section IV.2.5. 

Exit (F10) 
This function disconnects all instruments and terminates 
the program. 
 

Fig. III.4 'Export' commands 

Fig. III.5 'Measurement Report' dialogue 
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III.2 Edit Menu 

Copy (Ctrl+C) 
The function copies the result graph to the clipboard wherefrom it can be 
pasted into other applications. 

Setup (F1) 
The setups of the HVcontrol and STEPcompact and the ICMcompact 
can be adjusted if there is a valid connection to these instruments. If the 
tan delta is measured by a TDAcompact, its setup can also be adjusted. 
The HVcontrol and STEPcompact have seven different setups which 
can be stored in the instrument. In the following figures the dialogue 
boxes to edit these setups are shown. 

III.2.1 HVcontrol and STEPcompact Setup 

Pressing the 'Next' button of the dialogue box will show settings of the next setup tab. It is possible to load a 
setup from a stored file (*.hvp) by pressing the 'Load' button. The changed setups must be sent to the in-
strument by 'Send' or 'OK'. 'Cancel' will close the setup dialogue without changes. 
1. Input Max (X1:1,2) / Input Max (X1:4,5) / Input Max (X1:7,8):  

These boxes display the values that are set for the corresponding inputs within the hardware configura-
tion. 

2. Iprim:   
The value indicates the primary current, which will flow, when the maximum input voltage/current is 
reached. E. g.: If the hardware is equipped with a 10 V input, the current, which produces the 10 V, 
needs to be entered here. 

3. Limit Iprim:   
Maximum allowed primary current. If current is higher than this value, the HVcontrol will go back to initial-
isation, where all components are switched off. 

Fig. III.6 Edit menu 

Fig. III.7 Tabs for the HVcontrol and STEPcompact setup 
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4. Isec:   
The value indicates the secondary current that will flow when the maximum input voltage/current is 
reached. E. g.: If the hardware is equipped with a 5 A input, the current, which produces the 5 A, needs 
to be entered here. 

5. Limit Isec:  
Maximum allowed secondary current. If current is higher than this value, the HVcontrol will go back to ini-
tialisation but the regulating transformer will stay on. 

6. Uprim:  
The value indicates the primary voltage when the maximum input voltage is reached. E. g.: If the hard-
ware is equipped with a 10 V input, the voltage, which correlates to 10 V, needs to be entered here. 

7. T to Open Earth:  
When using an automatic earth bar, it can take some time to open the grounding. This time should be 
entered here in order to inhibit an error. 

8. Auto Shutdown:  
If auto shutdown is enabled, HVcontrol will drive the regulating transformer to its zero position automati-
cally when an emergency stop is initiated. When disabling this function, the regulating transformer needs 
to be driven to its zero position manually, before you can switch on again. 

9. Rapid Shutdown:  
The rapid shutdown function allows the HVcontrol to use the rapid drive mode to reduce the voltage after 
HV is switched off. 

10. Rapid Drive Delay:  
In manual drive mode this is the time you need to press the button until HVcontrol will switch on the rapid 
drive mode. 

11. Status:  
Indicates if this setup is the active setup of the instrument (Active) or not (Not Active). To change the ac-
tive setup of the instrument, the setup must be selected, and this box has to be set to 'Active'. 

12. Setup Label:  
The name of the setup can be changed to identify it more easily. 

13. Divider Ratio:  
The divider ratio of the HV voltage divider has to be inserted as a factor of 1: x  
E. g.: With a divider factor of 1000 a maximum measuring range of 100 kV is possible when the maxi-
mum voltage input is V_in max = 100 Veff. 

14. Control Window:  
The maximum difference of the set voltage and the actual voltage where the voltage will not be adjusted. 
If this value is set too small, the control is likely to oscillate around the set value and, thus, will stress the 
servomotor unnecessarily. 

15. Window Offset:  
Offset for the value of 'Control Window'. A value of 100 % assures that the actual voltage never un-
derruns the set voltage, while a value auf -100 % guarantees that the actual voltage never exceeds the 
set voltage. 

16. Slow Move Window:  
The voltage range around U_set, where the ‘HV up’ and ‘HV down’ relay is operated intermittently. By 
this it is possible to near U_set with slow speed (pulsed) and thus avoid oscillation around the set value. 
Setting this value has to be done in compromise of mechanical inertia and wear-out of the servomotor. 

17. Control Cycle:  
The maximum time in seconds for one cycle of driving and pausing the servomotor. This time will be 
started when the actual voltage is between the limits set in the slow move window and the control win-
dow. 

18. Duty Cycle:  
This value determines the ratio of time for moving and pausing the servomotor. 100% means no pause at 
all. 50% means that half of the time, which is set in control cycle, the servomotor is active, and the other 
half the servomotor will pause. This value has to be set according to the mass inertia of the servomotor. 

19. Control Timeout:  
The maximum time to reach the set voltage. If this time is exceeded without any voltage change, the 
servomotor will turn down the voltage (HV down) and the break off relay will be triggered. 
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20. Shut-off Hold:  
The period during which the HV down relay is on after the dU/dt Limit is exceeded. When using the 
HVcontrol from Power Diagnostix this time can be set short, since the HVcontrol already ensures driving 
the transformer tape to the zero position. 

21. LVD:  
Voltages below this value will be displayed and recorded as 0 V. 

22. TTL Gate Out:  
An optional extra output terminal of the HVcontrol provides a TTL signal each time the HV up or HV 
down relay is triggered. Since in some test setups the relay bouncing leads to disturbances on the 
ICMcompact, this signal can be used to gate this noise. Three different modes can be selected: 
Off - Gating output inactive  
On - TTL signal is active while an output is switched, or the regulation transformer is in operation. 
Pulsed - TTL signal is only active during the 'TTL Gating Time'. 

23. TTL Gating Time:  
Gating time in seconds. 

24. REC OUT:  
The REC OUT terminal may optionally be connected to a paper recorder or other device to provide a 
graph of the voltage magnitude. The voltage output gives 0 to 10 V and corresponds linearly to the dis-
played voltage. 
This value should be set above the maximum expected voltage value. E. g.: If a step curve goes up to 
65 kV, the REC OUT can be set to 100 kV. This is the displayed voltage which equals the maximum out-
put voltage (= 10 V) at the REC OUT terminal. A displayed voltage of 60 kV will then refer to 6 V at the 
REC OUT terminal. The REC OUT voltage is altered together with the change of the display of Û, Û/Ö2, 
URMS. 

25. dU/dt Mode:  
If the voltage limit defined by dU/dt Sensitivity is exceeded, the dU/dt mode defines the action which is 
taken: 
Off - No action  
Counter - The number of dU/dt events will be increased.  
Relay - The relay contact of either the relay unit or the HVcontrol is switched, and the voltage is shut 
down. 

26. dU/dt Sensitivity:  
The maximum voltage alteration per second. When this value is exceeded, the break off relay is trig-
gered and the variac will be turned down. 

III.2.2 ICMcompact Setup 

It is also possible to load an ICMcompact setup from 
a stored file (*.cmp). 

Device Identity: Sets the identification of the instru-
ment. 
1. Phase Shift:  

The position of the PD in relation to the zero 
point of the synchronisation voltage line. 

2. Gain:  
Sets the amplification of the signal path. The to-
tal amplification is a combination of pre-
amplification (external preamplifier) and main 
amplification (internal). 

3. LLD:  
Sets the level of the low level discriminator. All 
discharge pulses below that level are deleted. 

Fig. III.8 Tab for the ICMcompact setup 



HVpilot High Voltage Test Control Software 
9 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

4. Highpass:  
Sets the lower cut-off frequency of the highpass filter. 

5. Lowpass:  
Sets the upper cut-off frequency of the lowpass filter. 

6. Q Cal:  
Shows the value of the actual calibration. 

7. Window:  
Sets the number of windows for the window gating. 

8. Win Pos.:  
Sets the phase position of the first window. 

9. Win Width:  
Sets the width for the windows. 

10. Ext. Gating:  
Activates the external gating function. There are two different modes for the external gating function. In 
the manual mode the threshold level can be set directly. If the gating signal exceeds this level then the 
measurement PD signal is cleared for about 100 µs. In the auto mode the gating time can be set and 
the threshold level is automatically adjusted by the instrument. 

11. Threshold:  
Sets the threshold level. 

12. Bandwidth:  
Sets the frequency range for the preamplifier at the gating input. 

III.2.3 TDAcompact Setup 

1. Standard Capacitor:  
Sets the value of the standard capacitor in the 
measuring circuit. 

2. Shunt Std Capacitor:  
Sets the value of the shunt at which the current at 
the standard capacitor is measured. 

3. Shunt Test Object:  
Sets the value of the shunt at which the current at 
the test object is measured. 

4. Device Identity:  
Sets the identification of the instrument. 

 

Fig. III.9 Tab for the TDAcompact setup 



HVpilot High Voltage Test Control Software 
10 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

Step Edit 
Voltage curves can be edited or created in the step edit dialogue box which is shown in figure III.10. 

The 'Step' and 'Ramp' buttons create a new step resp. ramp from the end of the last step to the cursor posi-
tion. If the cursor position is within the voltage curve no step or ramp can be created. The 'New' button de-
letes the voltage curve, and a new one can be defined. By pressing the 'Repeat' button the last step or ramp 
will be repeated. The last step is deleted each time the 'Delete' button is pressed. A voltage curve can be 
stored in a file. This is an ASCII file format and has the extension .hvc. A stored voltage curve can be loaded 
via the 'Load' button. To store a voltage curve, the 'Save' button has to be pressed. If an HVcontrol or a 
STEPcompact is connected, pressing 'OK' sends the changed voltage curve to the instrument. 

There are two possibilities to define a step or a ramp. The cursor can be placed at the respective voltage and 
time of the next step by clicking with the left mouse button and dragging the cursor or the required values 
can be entered directly in the boxes on the right-hand side. The button 'Step' or 'Ramp' will connect the curve 
with the new position. The first box 'Test Sequence' defines a name for the voltage curve. A maximum of 
30 characters can be put in. The 'Step box shows the step number at the cursor position. By changing this 
value, the cursor can be placed at the beginning of a step or in the middle of a ramp. The 'Time' box shows 
the total time of the voltage curve at the cursor position. Changing this value will change the cursor position. 
The value can be changed by clicking the up and down buttons on the left side or by putting in a value direct-
ly. The time format is: ddd:hh:mm:ss. The up and down buttons increase resp. decrease the value of the 
days, the hours, the minutes, or the seconds depending on the cursor position in the box. By default, the 
seconds are changed. The 'Step Duration' box shows the duration of the actual step. Changing this value will 
also move the cursor. The 'Voltage' box shows the voltage at the cursor position. The 'Step Duration' and 
'Voltage' values can only be changed for a new step. For this the cursor must be on the right of the voltage 
curve. The difference of the voltage between the voltage at the actual cursor position and the voltage of the 
previous step is shown in the 'Step Voltage' box. 

The cursor can be moved by clicking the left mouse button and dragging the cursor or by pressing the arrow 
keys. If the cursor is above the last sixth part of the y-axis or on the right of the last sixth part of the x-axis the 
graph is scaled up automatically. In the same way the graph is scaled down if the cursor is in the first sixth 
part of the x- and y-axis. 

Fig. III.10 'Step Edit' dialogue box 
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Report 
Additional information to a measurement or a test sequence can be put in via the report dialogue box. This 
data appears in the printout and is stored in the data file. Depending on the type of the measurement the 
additional information can vary. The standard report is shown in section III.1 with figure III.5. Other reports 
are shown in section IV. 

Define Test Sequences 
The program provides the possibility to define and carry out certain test sequences. These test sequences 
can be defined via the 'Test Sequence Template' dialogue box. There are six different types of test sequenc-
es called 'Sequences', 'Bushing Test', 'Profiles', 'Breakdown Test', 'Bushing Profiles', and 'Multiplexer Test'. 
For each type different parameters have to be defined. For more detailed information about these test se-
quences see section IV. 

Y-Axis Scaling 
While running a voltage curve, there is the possibility to 
set the y-axis scaling for the Q, U, tan delta, and Cx val-
ues manually. The dialogue box in figure III.11 provides 
two options for adjusting the y-axis scaling: automatically 
and manually. If manually is selected, the maximum val-
ue for the displayed range of the measurement category 
must be put in. The range then will not be changed even 
if there are values greater than the maximum. The auto-
matic mode adjusts the range to the measured values. 

 

Auxiliary Board Settings 
An ICMcompact can be ordered with up to eight auxiliary input channels (AUX). These inputs can be used to 
record additional signals like power, temperature, pressure etc. A USB interface is used to link the 
ICMcompact instrument with the software, running on a standard PC. 

Fig. III.12 Auxiliary board settings dialogue box 

Fig. III.11 Y-axis scaling 
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I/O Card Settings 
The HVpilot software can con-
trol several I/O cards of Na-
tional Instruments that can be 
optionally installed on the PC. 
Depending on the status of an 
input (active/inactive), the 
software can define actions to 
be executed. For every input 
and output one ac-
tion/condition can be defined. 
1. Inputs:  

If an input is set to active, a 
command of the HVcontrol 
software will be executed. 
E. g. If line1 of port 0 (P0.1) 
is set to 'active' a test se-
quence will be started, 
while an active PO.2 will 
end the test. 

2. Outputs:  
An HVcontrol function can 
set an output port of the I/O 
card. E. g. it can set an 
output to active when a test 
was finished. 

 
Depending on the type of a 
test, which can be selected 
with the dropdown menu 'Test', 
different functions can be se-
lected for the in- and outputs. 

Fig. III.13 Configuration of an optional I/O card 
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III.3 View Menu 

Button Bar 
Show / hide button bar. 

Clear Chart 
This option is only available if the strip chart view is active. In 
the strip chart view all measured values are displayed contin-
uously. This function clears this view, and the next measured 
values are displayed at the left border. 

Strip Chart and Result Graph 
Toggles between the two views. 'Result Graph' shows the 
results of a measurement. 

Peak Suppression for Charge Curve 
This function removes all peaks from a PD measurement that were caused by external intermittent noise or 
switching pulses. 

Max. Qp Values 
If enabled, the maximum Qp value for every channel will be displayed after the test. Only for multiplexer 
tests. 

Test Status Window 
Displays the status and several user-specified test parameters, such as a product type. Only for multiplexer 
tests.  

 

Fig. III.14 View menu 

Fig. III.15 Status window 
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Pattern Window 
If enabled, this window displays the current ongoing pat-
tern acquisition or the last recorded pattern. Additionally, 
it's possible to display a recorded pattern ('dat' file) by 
dragging & dropping the corresponding file into the win-
dow. 
 
 
 
 
 
 
 

III.4 Connect Menu 

Search (F3) 
This function searches for an HVcontrol/STEPcompact, an ICMcompact, and a tan delta measuring bridge 
on the enabled COM ports, which can be set in the 'Interface Settings' dialogue box. The result is shown in 
the search dialogue box (see section II). 

Disconnect ICMcompact / STEPcompact / TANdelta 
These functions establish a connection to the corresponding instrument or disconnect it. If an instrument 
shall be connected, the respective function scans the COM and establishes the connection if available. 

III.5 Measurement Menu 

The measurement menu items are only available if a STEPcompact or an HVcontrol is connected. 

Fig. III.18 Measurement menu 

Fig. III.16 Pattern window 

Fig. III.17 Connect menu 
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Automatic Test Control 
This command opens a pop-up window that offers the possibility to choose the type of test and to start it. 
Besides templates HVpilot offers pre-defined automatic tests. 

Manual Control 
This function opens a dialogue box to set the voltage manually. By 
pressing OK the HVcontrol/STEPcompact controls the voltage to 
the entered value. The value refers to the actual type of voltage 
value (Û, Û/Ö2 or Urms). This option can be selected only, if no step 
test is running.  

 

 

 

Templates ► 

Load Test Template 
By selecting this menu option, a predefined test sequence can be loaded (*.tpl). After loading a test se-
quence, only the defined measurements can be carried out and the results will be calculated automatically. 

Close Test Template 
The loaded test sequence will be closed, and all program settings are available again. 

Define Test Template 
Opens a window to define a new test template. 

Fig. III.20 Dialogue box for voltage setting 

Fig. III.19 Open dialogue to start a pre-defined test 
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III.6 Options Menu 

Special Settings 

1. Manual Test Sequence: 
Here, parameter for a manual test sequence can be set. 
· Number of Values: Number of values that should be measured in order to determine an average value 
· Number of Peaks: Number of the highest values that should be ignored when determining the aver-

age value 
· Release Button at: Manual measurements are made by pressing the corresponding software buttons 

at the set voltage level. This entry defines a tolerance value for the voltage which 
allows using the measuring buttons although the voltage has not exactly the set 
value. 

· Noise Level: This value is displayed as noise level in the test report. 

2. Special Bushing Test Settings: 
The strings offer the possibility of defining information that is used for a summarising report of bushing 
tests. 
 

Fig. III.22 'Special Settings' dialogue 

Fig. III.21 Options menu 
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3. Consecutive Test Settings: 
These settings determine the behaviour of the Qp acquisition mode for consecutive tests.  
- Average: The average of the Qp values gathered during a step is used for evaluation (so for 

comparing with the limit set) 
- Minimum: The minimum Qp value gathered during a step is used for evaluation. 
- Maximum: The maximum Qp value gathered during a step is used for evaluation. 

4. Miscellaneous: 
· Voltage Monitoring: 

It's possible to monitor the voltage. In case of exceeding the pre-set voltage limit the software will au-
tomatically reduce the voltage. 

 
If the function is activated, the following settings should be made: 
· Threshold: If the voltage value exceeds the pre-set value the monitoring process will be 

started. 
· On Time: Maximum operation time with the voltage exceeding the pre-set threshold value 
· Off Time: Minimum time period after operation with the voltage exceeding the pre-set 

threshold value. 

· Pattern Acquisition: Activates automatic pattern acquisition on each step. The step test will be paused 
when pattern acquisition is running and will continue afterwards. 

If the function is activated, the following settings should be made: 
· Set Time: With this setting, a pattern is recorded at each stage of a test (except UHF tests) 

or by pressing the button 'Start Pattern'. The length of the stages in a power 
curve should therefore correspond to the duration of the pattern recording, other-
wise the duration of the measurement may exceed the step length. With software 
version 2.3 or higher the value is automatically reduced by the software, if neces-
sary, to meet the requirements above mentioned. 

· Delay (Step Tests): Specifies the delay between reaching a step and starting the pattern acquisition. 

· Peaks to Ignore (UHF-Test): 
Specifies the number of PD peaks above the minimum PD level for the IE part of an UHF step test, 
resp. above the inception level for the UHF part, before the UHF test specimen has failed the test. 

· Database: 
Database name 
Please note: The software must be restarted after changing the database entry. Furthermore, please 
make sure that the new database is registered as Windows ODBC data source. If not HVpilot will 
show the error message "Database linkage failed!" when trying to start the consecutive test with the 
automatic test control. To check, if the database is registered, use the Windows ODBC data source 
administrator (see figure III.23), which can be started with:  
Start->Settings->Control Panel->Administrative Tools->Data Sources (ODBC). 
HVpilot uses the entries during start-up to find the database that is specified in the special settings. 

 

 

Warning: 
 

· This function should be used as an additional system protection tool but not as a main pro-
tective function, since in the case of a communication failure or a crash a controlled shut-
down of the voltage can't be guaranteed. An external fast disconnector switch is mandatory 
to protect the system and the operator in case of a breakdown! 

! 
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· Scan Time Interval / Channel: 
For multiplexer tests only. Scanning time for one channel before changing to next channel. 

· Voltage Transient Time: 
Specifies the delay between reaching a step and using the measured values for test evaluation to 
suppress peaks caused by the voltage change. 

· Select active Setup per Template: 
If activated, it's possible to specify, which of the seven setups of the HVcontrol should be used for a 
test. 

· Show extended Voltage Information: 
Shows Uprim / Iprim / Isec (only available in 1024x768 resolution)  

5. Consecutive Batch Settings: 
These settings refer to the consecutive batch test, which allows testing of multiple test specimens con-
nected simultaneously (in parallel on one channel) for PD inception and extinction voltage until enough 
test specimens have passed the test. 
· Verification: Determines whether the necessary PD 

calibration is verified before performing 
the first batch, before every batch, or 
never. 

· Cal. Verification: Determines if the verification is done 
manually or automatically 

· Tolerance: Allowed deviation in percent of the set 
calibration value if verification is done 
automatically. 

Export Date Format 
Offers several date formats for use with the HVpilot software. 

Display Resolution 
The display resolution of the main panel can be toggled between 800x600 and 1024x768 pixels. 

Fig. III.23 Windows ODBC data source administrator 

Fig. III.24 Calibration verification pop-up 
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Language 
The language of the program can be switched between English and German. 

Interface Settings 

Normally the settings of this dialogue box need not to be changed. But in case there are problems with the 
serial communication, changes can be made. If the PC uses others than the first four COM ports to connect 
to the devices, these can be enabled by setting the corresponding check boxes. The 'RSR232 Search 
Timeout[s]' is the time the PC waits on an answer on a COM port while searching for devices. If the PC often 
doesn't find a device on a COM port even though there is a device connected, this time can be increased. 
The 'RSR232 Run Timeout[s]' sets the time the PC waits on requests over the COM ports. If the device often 
is disconnected because of communication errors this time can be increased. By pressing the 'Standard' 
button the settings are reset to those values shown with the left part of figure III.25. 

Start Mode 
Offers the possibility to specify a test that is automatically started at software launch. 

Autosave Settings 
This option opens a pop-up window with settings for 
files that are automatically generated after a test. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. III.25 Interface settings dialogue box (standard settings) 

Fig. III.26 Autosave settings 
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User Administration 
The HVpilot software comes with a user administration that allows setup and managing user accounts with 
different user rights. This option is only available for users with administrator rights. The settings are only 
used, if 'Require Login at startup' is enabled. The 'Rights' button opens a second window that allows setting 
the rights for standard users. 

Change Password 
Offers the possibility to change the own user password. 

Fig. III.27 User administration and 'Rights' window 
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IV Test Sequences 

There are six different kinds of test sequences. For all test sequences a template must be defined first. Then 
the template can be loaded and started. Predefined test sequences can be loaded directly via the 'Load' 
option of the 'File' menu. At the end of the test a report is created. 

1. Sequence 
Sequence is designed for tests which need the measurements of PD activity, tan delta, and/or the capaci-
tance at predefined voltage levels. There is the possibility to define two different sequences in one test. 

2. Bushing Test 
The second kind of test sequence is designed especially for bushing tests. See page 25. 

3. Profile Test 
The third kind of test sequence allows setting the maximum PD levels at certain voltage values (for e. g. 
acceptance tests). It is possible to set up to four different PD levels for each voltage. 

4. Breakdown Test 
The fourth kind of test sequence is designed for breakdown tests. 

5. Bushing Profile Test 
For this test an ICMcompact with MUX option is mandatory. The fifth kind of test sequence is similar to multi-
plexer tests. Additionally, there's the possibility to define special functions for an I/O card. 

6. Multiplexer Test 
For this test an ICMcompact with MUX option is mandatory. This kind of test sequence is similar to profile 
tests. It allows setting one maximum PD level, that marks the pass and fail point for the acceptance test. 
Additionally, you can define a breakdown level. If the measured PD exceeds this value, the test is automati-
cally cancelled. 

IV.1 Sequences 

First a template must be defined for the test sequence. Figure IV.1 shows the dialogue box which is opened 
by 'Define Test Sequences'. Information about the test object can be defined in the first three boxes. The 
kind of test sequence is determined by the six tabs 'Sequences', 'Bushing Test', 'Profiles', 'Breakdown Test', 
'Bushing Profiles', and 'Multiplexer Test'. If 'Sequences' is selected, one or two different sequences can be 
defined. At the end of a test sequence a report is generated automatically. The layout of the report can be 
designed individually. The program uses predefined Word documents and replaces the tags in it with the 
data of the test sequence (see section IV.1.2). The sequences themselves can be defined on the '1. Test 
Sequence' and '2. Test Sequence' tabs. 
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Automatic and manual sequences are available. An automatic sequence runs a predefined voltage curve 
automatically, i. e. the voltage is set and controlled by the HVcontrol/STEPcompact and the values of the PD 

activity, the tan delta, and/or the capacitance are 
measured continuously. At the end of the se-
quence the measured data is evaluated. Where-
as by running a manual test the voltage has to 
be controlled manually and measuring values are 
taken by pressing a corresponding button. This 
mode can be used if there is no possibility to use 
the HVcontrol/STEPcompact for voltage meas-
urements. To identify the sequence a name can 
be given in the 'Name' box. The voltage curve for 
the automatic mode can be defined by clicking 
on the 'Selected Voltage Curve' box. If the PD 
activity is to be measured, the corresponding 
check box must be enabled. For this purpose, an 
ICMcompact must be connected. The voltage 
values at which the PD activity is to be measured 
can be set in the 'Measuring Points' box. The 
voltage values must be separated by commas, 
slashes, or semicolons. The number of values 
must not exceed 50. If an automatic sequence is 
defined, the values must correspond with steps 
of the voltage curve. By double-clicking on the 
box, a dialogue box opens which shows the step 
curve. By moving the cursor on a step voltage 
and double-clicking this voltage, a measuring 
point is defined. If the PD inception and extinc-
tion voltages shall be calculated, the level of the 
PD activity, which indicates that the partial dis-
charge has started, must be adjusted. The noise 
is the minimum value for the PD activity in the 
result table of the report even if there are lower 
measuring values. 

If the tan delta and the capacitance are to be 
measured, the corresponding check boxes must 

be enabled. The software supports two different tan delta measuring instruments: Power Diagnostix' 
TDAcompact and the Tettex 2877. The type of the instrument must be selected in the 'Device Type' box. The 
measuring points can be defined in the same way as for the PD measurement but need not to be identical. 
When using the Tettex 2877 tan delta measuring bridge the value of the standard capacitor must be set. By 
using the TDAcompact the values of the two shunts must be set as well. These values need not to be ad-
justed at the instrument but are set by the software when the sequence is started. 

The evaluation of the measuring data is made at the end of the test sequence. As the voltage is hold at eve-
ry measuring point for a while there are several measuring values of the PD activity, the tan delta, and the 
capacitance. The chosen 'Acquisition Method' determines how these values are evaluated. By selecting the 
'Average Value' method all values are summed up and then divided by the number of measuring values. The 
'Maximum' and 'Minimum Value' method uses the maximum resp. minimum value of the measuring values. 
As the regulator needs some time to reach the step voltage, a certain time can be set by the Voltage Stability 
after box after which the measuring values are evaluated at the measuring points. This can prevent to in-
clude peaks, which can occur by driving the motor of the regulator, into the evaluation of the test sequence. 
The second sequence can be defined in the same way. 

 

Fig. IV.1 Template dialogue box, test sequence tab 



HVpilot High Voltage Test Control Software 
23 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

IV.1.1 Additional Test Information 

After starting the test sequence additional information about it must be entered. The dialogue box in fig-
ure IV.2 shows the needed data. 

The first three items are the same as in the 
general settings sheet of the template dia-
logue box. The next four are additional 
order information. The last three items 
concern the test conditions. All this infor-
mation can be placed in the report. The 
check boxes in the next section define if 
the report shall be automatically created at 
the end of the test sequence, if the incep-
tion and extinction voltage and the result 
graphs shall be included in the report, and 
if the report shall be printed automatically. 
In the next section the order of the two 
sequences can be set. The last section 
determines the language of the report. 

 

 

 

Fig. IV.2 Additional information dialogue box 
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IV.1.2 Customising the Report 

The report template for this sequences test is located in the 'Default Docs' directory and the names of the 
files are default_standard_<language>.doc. <language>: en (English), ge (German), fr (French). According 
to the choice of the language of the report, the corresponding template is used for the report. These tem-
plates can be customised concerning the layout. The data of the test sequence replaces the tags in the re-
port. The predefined tags for this kind of test sequence are: 

Mark Description 
<TAG_DATE> test date 
<TAG_TIME> test time 
<TAG_OBJECT> test object 
<TAG_TYPE> test type 
<TAG_TESTSPEC> test specification 
<TAG_INCEPTPDLEVEL> inception PD level 
<TAG_INCEPT> inception voltage 
<TAG_EXTINCT> extinction voltage 
<TAG_CLIENT> name of client 
<TAG_ORDERNO> order number 
<TAG_SERIALNO> serial number 
<TAG_TESTPERSON> testing person 
<TAG_TEMPERATURE> air temperature 
<TAG_PRESSURE> air pressure 
<TAG_HUMIDITY> humidity 
<TAG_COMMENT> comment about the test 
<TAG_GRAPH> position to insert the graph of the measurement 
<TAG_RESULTSTABLE> table with the measuring results 

Table 1: Definition of tags for the report of a sequences test 

The last two tags only indicate the position where the result graph and table are to be inserted in the report. 
The layout of the graph and the table cannot be affected. The tags must be enclosed in angle brackets and 
must be written as shown in table 1. Not all tags need to be contained in the report template. 

IV.1.3 Test Cycle 

A sequence test can be loaded either by selecting 'Load' item of the 'File' menu or via the 'Define Sequence 
Template' dialogue box by pressing the 'OK' button. After that the additional information about the test can 
be put in. Then the software checks if all necessary devices are connected and establishes a connection to 
them. After that the test can be started. Then the sequences are carried out and at the end the data and the 
report can be saved. 
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IV.2 Bushing Test 

The bushing tests are carried out according to 
IEC 60137 or IEE E C57.19.00. Other testing 
standards are possible but need to be custom-
ised. The general settings of the template dia-
logue box are equal to those of a sequence test 
except that the type and object boxes cannot be 
filled in. The sequences sheets are slightly differ-
ent. It is possible to set a PD and tan delta limit. 
These tolerance ranges are controlled by the 
software. At the end of a test, the testing person 
is asked what to do, if the measured values are 
out of these ranges. The dialogue box shows the 
values which are out of range and the testing 
person has to decide if the test is ok neverthe-
less, if the test shall be repeated, or if the results 
are to be discarded. Another difference to a se-
quence template is, that no inception PD level 
can be set, because the inception voltage is not 
calculated in a bushing test. All other settings are 
the same as for sequence tests (see sec-
tion IV.1). 

 

 

 

Fig. IV.3 Bushing sequence tab 
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IV.2.1 Additional Test Information 

After starting the test sequence, additional 
information about it must be entered. The 
following dialogue box shows these data for 
a bushing test. 

In the first section information about the 
order can be set. The second section de-
fines the kind of test and a comment about 
the test can be entered. For a repetition test 
a comment is obligatory. In the next section 
the order of the two sequences can be set. 
The last section determines the language of 
the report. 

 

Fig. IV.4 Bushing test information dialogue box 
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IV.2.2 Customising the Report 

The report template for the bushing test is located in the 'Default Docs' directory and the names of the files 
are default_bushing_<language>.doc. <language>: en (English), ge (German), fr (French). According to the 
choice of the language of the report, the corresponding template is used for the report. These templates can 
be customised concerning the layout. The data of the test sequence replaces the tags in the report. The 
predefined tags for this kind of test sequence are: 

Mark Description 
<TAG_DATE> test date 
<TAG_TIME> test time 
<TAG_OBJECT> test object 
<TAG_TYPE> test type 
<TAG_TESTSPEC> test specification 
<TAG_CLIENT> name of client 
<TAG_CLIENTORDERNO> client order number 
<TAG_ORDERNO> order number 
<TAG_POSITIONNO> position number 
<TAG_SERIALNO> serial number 
<TAG_TESTPERSON> testing person 
<TAG_QUANTITY> quantity 
<TAG_DRAWING> drawing number 
<TAG_TEMPERATURE> air temperature 
<TAG_TESTTYPE> type of test (preliminary test, repetition, repair, final inspection) 
<TAG_TESTTYPECOMMENT> comment about the type of test 
<TAG_COMMENT> comment about the test 
<TAG_UPEAK> maximum value of the voltage in a test sequence 
<TAG_NOISE> background noise 
<TAG_GRAPH> position to insert the graph of the measurement 
<TAG_RESULTSTABLE> table with the measuring results 
<TAG_TEXT1.0> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.1> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.2> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.3> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.4> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.5> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.6> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.7> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.8> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT1.9> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.0> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.1> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.2> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.3> additional text defined in the <Bushing Texts.xls> file 
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Mark Description 
<TAG_TEXT2.4> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.5> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.6> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.7> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.8> additional text defined in the <Bushing Texts.xls> file 
<TAG_TEXT2.9> additional text defined in the <Bushing Texts.xls> file 

Table 2: Definition of tags for the report of a bushing test 

The <TAG_GRAPH> and <TAG_RESULTTABLE> tags only indicate the position where the result graph and 
table are to be inserted in the report. The layout of the graph and the table can't be affected. The tags must 
be enclosed in angle brackets and must be written as shown in the table. Not all tags need to be contained in 
the report template. 

The <TAG_TEXT1.0> - <TAG_TEXT2.9> tags can be defined in the Bushing Texts.xls Excel worksheet 
which is also located in the 'Default Docs' directory. 

IV.2.3 Special Configurations for Bushing Tests 

There are predefined bushing tests according to the IEC and IEEE test standards. To load such a test, only 
the type of the bushing, in some cases the filling, the testing standard and the Ur or BIL value must be se-
lected, and the correct template is loaded automatically. This easy possibility to load a bushing test needs 
some configurations. These are made in the Bushing Texts.xls file in the Default Docs directory. The first 
'Types' sheet defines the bushing types with their fillings and the possible testing standards. The first column 
'No.' is filled in automatically and must not be changed. The next two columns define the type of the bushing 
in German and English. The columns 'Filling DE' and 'Filling EN' define the filling for the type of the bushing. 
If a type has no filling '(keine)' must be filled in. The next columns define the testing standards for the type of 
the bushing. Further testing standards can be added with a new column. The headline of the new columns 
must start with 'Testing Standard' followed by a blank and a number. Each combination of type and filling 
needs its own row. 

The specifications for the testing standards are defined in the 'Testing Standards' sheet. For each testing 
standard defined in the 'Types' sheet there is a corresponding column in the 'Testing Standards' sheet. The 
first two columns define the Ur and BIL values and the columns of the testing standards define the file names 

Fig. IV.5 Defining types of bushings in the Bushing Texts.xls file 
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of the bushing test templates which are located in the 'Templates' directory. These templates contain the 
voltage curves and measuring points for the combination of Ur resp. BIL and the testing standard. 

The <TAG_TEXT1.0> - <TAG_TEXT2.0> tags for the report templates are filled with the texts defined in the 
'Texts' sheet. For each combination of a type of bushing and a filling there is a row in the sheet. The columns 
'Text 1.0 DE/EN' up to 'Text 2.9 DE/EN' define the texts for the corresponding tags. So, each type/filling 
combination has its own text definition. The texts itself can contain other defined tags but no <TAG_TEXT..> 
tags. 

 

Fig. IV.6 Defining the names of the template files for the testing standards 

Fig. IV.7 Defining the texts for the corresponding tags 
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IV.2.4 Test Cycle 

A bushing test is selected and started by choosing a 
bushing test template in the 'Load Automatic Test 
Control' window. If done, the following dialogue box 
for selecting the test is opened. Each box shows the 
selectable possibilities. The first box displays all 
types of bushings from the 'Types' sheet. The sec-
ond box shows all corresponding fillings. The possi-
ble testing standards are shown in the third box. The 
Ur and BIL values are taken from the 'Testing 
Standards' sheet. The last box shows the template 
file for the selected bushing test. This template can 
be edited directly by pressing the 'Redefine Tem-
plate button'. This opens the template dialogue box 
as shown in figure IV.8. The template can be 
changed and saved. After closing the dialogue box, 
the previous appears again. Pressing 'OK' loads the 
corresponding template file, and the additional in-
formation about the test can be put in. Then the program checks and establishes the connections to the nec-
essary devices and the test can be started. At the end the report is generated automatically. The report and 
the data file are stored in the <default dir> \ <Order No> \ <Position No> \ <Serial No> directory, where the 
items are taken from the additional information dialogue box. The file names are built up as follows: <kind of 
test>XX.hvs resp. <kind of test>XX.doc with: 

<kind of test> 
· preliminary_test 
· repetition_test 
· revision_test 
· final_inspection 

XX: increasing two-digit number 

IV.2.5 Several Tests in one Report 

There is the possibility to combine several bushing 
tests in one report. By selecting 'Create Complete 
Report' in the 'File' menu the following dialogue box 
appears. There are two possibilities of selecting the 
bushing tests. If the first two items are selected, all 
data sets under the selected order directory which 
were final inspections are put in the report. With the 
third item it is possible to select the data sets manual-
ly. The name and directory of the report file can be put 
in directly or can be selected by the 'Filename' button. 
The order directory refers to the first two items and 
can be selected by the 'Directory' button or can be put 
in directly. If the third item is selected, the list box, and 
the 'Remove', and 'Select' buttons are available. The 
files can be selected by the 'Select' button and are 
displayed in the list box. To remove a file from the list, 
it must be selected and the 'Remove' button must be 
pressed. The 'Order Directory' box and the 'Directory' 
button are not available. After selecting the options, 
the report will be created. 

 

Fig. IV.8 Select bushing test dialogue box 

Fig. IV.9 Selection of several bushing tests for report 
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IV.3 Test Profiles 

By defining a test profile, PD limits for each volt-
age step can be set. At the end of the test the 
software controls if the measured values are 
within these limits. Up to four different classes 
can be defined. The general settings of the tem-
plate dialogue box are nearly the same as those 
of a sequence test in figure IV.10, except that the 
'Number of Sequences' box is replaced by a 
'Number of Classes' box. To define a test profile, 
at first a voltage curve must be specified. By 
double-clicking on the 'Selected Voltage Curve' 
box, the 'Select Voltage Curve' dialogue box is 
opened. This dialogue box corresponds to the 
'Step Edit' dialogue box, and the voltage curve 
can be defined (see section III.2). If the PD incep-
tion and extinction voltages shall be calculated, 
the level of the PD activity, which indicates that 
the partial discharge has started, must be adjust-
ed. The table for the class definitions contains 
one row for each step in the voltage curve. The 
PD limits can be typed in by double-clicking the 
corresponding table cell. if it is not necessary to 
set a limit for one step, a dash should be entered.  

The evaluation of the measuring data is made at 
the end of the profile test. As the voltage is hold 
at every measuring point for a while there are 
several measuring values of the PD activity. The 
chosen 'Acquisition Method' defines how these 
values are evaluated. By selecting the 'Average 
Value' method all values are summed up and 
then divided by the number of measuring values. 
The 'Maximum' and 'Minimum Value' method 
uses the maximum resp. minimum value of the 
measuring values. As the regulator needs some time to reach the step voltage, a certain time can be set by 
the 'Voltage Stability' after box, after which the measuring values are evaluated at the measuring points. This 
can prevent to include peaks, which can occur by driving the motor of the regulator, into the evaluation of the 
profile test. Each class is evaluated separately. 

Fig. IV.10 Definition of classes for a test profile 
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IV.3.1 Additional Test Information 

After starting the test sequence, additional 
information about it must be put in. The 
following dialogue box shows these data for 
a profile test. The first three items corre-
spond to those of the general settings 
sheet of the template dialogue box. The 
next four items are additional information 
about the order. The check boxes in the 
next section define, if the report shall be 
created at the end of the test sequence 
when the measured values are within the 
limits or when they are not within or in both 
cases. The language of the report can be 
set by marking the corresponding selection. 
The next check boxes define if the incep-
tion and extinction voltage and the result 
graphs shall be included in the report and if 
the report shall be printed automatically. It 
is possible to export the measuring data to 
excel automatically by selecting the corre-
sponding check box. With the next three 
items additional measuring values can be 
added to the excel sheet. 

IV.3.2 Customising the Report 

The report template for the profile test is located in the 'Default Docs' directory and the names of the files are 
default_profile_<language>.doc. <language>: en (English), ge (German), fr (French). According to the choice 
of the language of the report, the corresponding template is used for the report. These templates can be 
customised concerning the layout. The data of the test replaces the tags in the report. The predefined tags 
for this kind of test are: 

Mark Description 
<TAG_DATE> test date 
<TAG_TIME> test time 
<TAG_OBJECT> test object 
<TAG_TYPE> test type 
<TAG_TESTSPEC> test specification 
<TAG_INCEPTPDLEVEL> inception PD level 
<TAG_INCEPT> inception voltage 
<TAG_EXTINCT> extinction voltage 
<TAG_CLIENT> name of client 
<TAG_ORDERNO> order number 
<TAG_SERIALNO> serial number 
<TAG_TESTPERSON> testing person 
<TAG_COMMENT> comment about the test 
<TAG_GRAPH> position to insert the graph of the measurement 
<TAG_RESULTSTABLE> table with the measuring results 

Table 3: Definition of tags for the report of a profile test 

Fig. IV.11 Profile test information dialogue box 
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The last two tags only indicate the position where the result graph and table are to be inserted in the report. 
The layout of the graph and the table can't be affected. The tags must be enclosed in angle brackets and 
must be written as shown in table 3. Not all tags need to be contained in the report template. 

IV.3.3 Test Cycle 

A profile test can be loaded either by selecting 'Load' from the 'File' menu or via the 'Define Sequence Tem-
plate' dialogue box by pressing the 'OK' button. After that the additional information about the test can be 
entered. Then the software checks if all necessary devices are connected and establishes a connection to 
them. After that the test can be started. At the end the data and the report can be saved. 

IV.4 Breakdown Test 

The general settings of the template dialogue box 
are nearly the same as those of a sequence test 
in figure IV.12, except that the 'Number of Se-
quences' box is not available. By defining a 
breakdown test only a few parameters must be 
set, the voltage curve is then created automatical-
ly. At first the start voltage for the first step must 
be set. The 'Step Voltage' box defines the step 
voltage for all following steps. There can be up to 
198 steps in a voltage curve with newer HVcon-
trols/STEPcompacts. The duration of each step 
can be set in the next box. In the last box the 
maximum reachable voltage with those settings is 
displayed. 

The number of steps should be limited, because 
this value, in combination with the step duration, 
determines the resolution of the measurement. 
The maximum number of measuring points for 
every measurement is 86400. This means one 
measuring point every second for a whole day. If 
the total time of a voltage curve is longer than a 
day, the time interval between two measuring 
points is calculated by dividing the total time by 
86400. If the step duration is predetermined and a 
long time period, the number of steps should be 
reduced as required to get the best resolution. 

The second section defines the first step. It can 
be step or a ramp with a settable duration. All 
other steps are real steps. 

After setting these parameters the voltage curve 
is created automatically. 

 

Fig. IV.12 Definition of a breakdown test 
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IV.4.1 Additional Test Information 

After starting the test sequence, additional 
information about it must be put in. The 
following dialogue box shows these data for 
a breakdown test. The first three items 
correspond to those of the general settings 
sheet of the template dialogue box. The 
next four items are additional information 
about the order. The last item sets the 
number of test samples which are to be 
tested until their breakdown voltage. The 
language of the report can be set by mark-
ing the corresponding selection. If the result 
graph is to be included in the report, the 
corresponding check box must be enabled. 
The next check box defines if the report 
shall be printed automatically. It is possible 
to export the measuring data to excel au-
tomatically by selecting the corresponding 
check box. With the next three items addi-
tional measuring values can be added to 
the excel sheet. 
 

 

IV.4.2 Customising the Report 

The report template for the breakdown test is located in the 'Default Docs' directory and the names of the 
files are default_breakdown_<language>.doc. <language>: en (English), ge (German), fr (French). According 
to the choice of the language of the report, the corresponding template is used for the report. These tem-
plates can be customised concerning the layout. The data of the test replaces the tags in the report. The 
predefined tags for this kind of test are: 

Mark Description 
<TAG_DATE> test date 
<TAG_TIME> test time 
<TAG_OBJECT> test object 
<TAG_TYPE> test type 
<TAG_TESTSPEC> test specification 
<TAG_CLIENT> name of client 
<TAG_ORDERNO> order number 
<TAG_SERIALNO> serial number 
<TAG_TESTPERSON> testing person 
<TAG_TESTSAMPLESNO> number of test samples 
<TAG_TESTTIME> total time of the test, including pausing time etc. 
<TAG_COMMENT> comment about the test 
<TAG_GRAPH> position to insert the graph of the measurement 
<TAG_RESULTSTABLE> table with the measuring results 

Table 4: Definition of tags for the report of a profile test 

Fig. IV.13 Breakdown test information dialogue box 
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The last two tags only indicate the position where the result graph and table are to be inserted in the report. 
The layout of the graph and the table can't be affected. The tags must be enclosed in angle brackets and 
must be written as shown in table 5. Not all tags need to be contained in the report template. 

IV.4.3 Test Cycle 

A breakdown test can be loaded either by selecting 'Load' from the 'File' menu or via the 'Define Sequence 
Template' dialogue box by pressing the 'OK' button. After that the additional information about the test can 
be entered. Then the software checks if all necessary devices are connected and establishes a connection 
to them. After that the test can be started. The software pauses the test after each breakdown and stores the 
last voltage and the duration of the test at that time. After resuming the test, the voltage rises until the last 
voltage and the test continues at the time of the last breakdown. At the end the data and the report can be 
saved. It is possible to stop the test manually and to continue the test later. 
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V Appendix 

V.1 National Instruments Hardening Guide 

Introduction 

This manual will guide you through the Power Diagnostix proposed cyber security operation system harden-
ing after the installation of a National Instruments based software product. The configuration refers to the 
Power Diagnostix software products, only. If any other 3rd party National Instruments based software prod-
ucts are installed or required, the proposed configuration should be adjusted with the configuration of the 
responsible manufacturer. 

This configuration guide will close three unnecessary National Instruments services. Furthermore, the local 
Port 3848 UDP and TCP opened by these services will be closed. 

 

Ste
p-
by-

Step Guide 

1.) Open the windows start menu and type “services.msc”. 

2.) Click onto the search result named "Services". The "Services" 
window will open. 

3.) Locate these services in the service list: 
· NI Domain Service 
· NI PSP Service Locator  
· NI Time Synchronization 

4.) Open the configuration popup by double click each service 
and change the "Startup type" to "Disabled". 

5.) Save the changes with the button "OK". 
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Service Description 

http://www.ni.com/product-documentation/14487/en/ 

 

 

 

 

 

 


